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Door with Winged Figure of the Goddess 
ARAS Archives 2Ak.700

Keys

Welcome to this living treasure, a rich gathering of

 archetypal symbols. These living presences touch the imagination and relate 

to the creativity in the depths of all human beings as the basic substance of 

life. Beyond the threshold, what awaits you moves as a rich web of images 

and symbols with surprising and sometimes astonishing interconnections. 

Venturing into this realm, one comes upon unfolding layers of meaning. 

Exploring these layers involves a certain kind of fluid movement and play that 

can bring with it elements of humor and wonder. 
W
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ARAS Search screen

Inviting Wonder
The journey into the Archive often begins with a dream image, an inspiration,  an interest in a motif, a wondering.  A beginning image 
can serve, like Ariadne’s thread, as a line to follow through the myriad entries in the Archive. Many individuals naturally enter the 
collection from a visual perspective and find the images lead deeper and deeper into meanings and understandings. These images are 
archetypal and do not necessarily relate to things concrete so much as things perceived indirectly. There is a kind of play involved in 
tracing the archetypal image and its symbolic facets that point beyond the thing itself. There is a play, too, involved in not holding too 
tightly to a word or image, yet, at the same time, staying with the image and its meanings without identifying oneself with it. 

Beginning the Journey
If you are looking for a source of inspriration, try selecting Search and then select Discover.  This will bring up a montage. You may 
then  click an image as it floats across the screen to see the image’s record details. Once you have clicked an image, selecting Discover 
a second time on the drop-down menu will take you to a new motif.  (Keys such as this are interspersed throughout the tutorial.)

For the purpose of this tutorial, we will work with a particular image. Imagine that the image of a fish appears in a dream and 
reappears over the course of a week in various forms—maybe on the radio as the name of a band or on the license plate of the car in 
front of you. Maybe fish shows itself on the cover of a magazine or in a painting with swirling koi in a gallery window.  However it 
shows up, you feel that somehow  something is trying to catch your attention by revisiting you. By giving the image your attention, 
not necessarily to figure it out, but to tend the deeper mysteries it may reveal, you can loosen formulated, fixed ideas and allow 
greater insight to emerge. A woman shares a dream:

I am walking behind my female friend along a narrow walkway of stones next to a rolling river. Because it is stormy, the 
river is rushing and the air is brisk. The mist engulfing us is a light rain. We are next to the shoreline and the water is clear 
enough that I can see three large salmon swimming with the current. Every ten feet or so, we decide whether or not to dip 
our feet into holes in the pathway. It is a ritual or a cleansing process. I follow my friend’s lead and we are completely 
immersed in the exercise. Our walk is rhythmical and fluid, like a graceful dance. We are both wearing long, white, flowing 
dresses that blow in the wind as we dip, swirl. Water is all around us, at our feet and in the misty air. The sound of moving 
water is deafening. I am not sure whether it is dawn or dusk and the light is spectacular--a golden glow. We are part and 
particle of nature, part of the earth around us, part of everything. 

The dreamer feels the dream fish calls to her as a particularly charged image. A first step in engaging the image might be to find a 
basic  photograph or to  draw a picture actively re-imagining or recalling the qualities of the dream fish. Using the Archive, one may 
relate with fish by exploring the various record summaries that have associations to fish. The collection contains a wide scope of motifs  
gathered from a multitude of cultures in many forms including: artistic, mythological, ritualistic, spiritual, philosophical, and religious. 
Fish touch into each of these realms as they are found in images of art and story across the history of human beings. Existing in the 
cave paintings of Lascaux, the art of Paul Klee, and the flying imagery of Chagall, fish also fill Neptune’s watery realms out of which 
Aphrodite is born. 
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To enter the record, place the cursor over the record number. This will change the underlined 
number to a bright yellow. Click on this yellow number or either one of the photographs to enter 
the detailed record. 

Selecting the record locator number will show both photos in the image display screen on the left 
of the Main Commentary page. Alternately, if one or the other photograph is chosen, only one 
will display at a time. 

ARAS Search result example

At the top and bottom of the search Results Page, click on  “See as animation,”  to see a 
flowing procession of the images  found in that particular grouping. If you would like to 
follow an image, put the cursor over it and click.     

How to start a basic search 
This basic search begins with the general topic of fish to discover if a specific record draws you to view it. Upon typing fish in the Search the 
Archive box, a drop-down menu appears with a list of options for various categories referencing fish.

 In moving the cursor over the drop-down list, the different keywords are highlighted. If a selection is made inadvertently, one may choose to 
follow the lead or use the left arrow or back button at the top of the screen to return to the previous drop-down menu. Additionally, if you 
would like to change the text size, go to the View menu at the top of the page and select Zoom In or Zoom Out.

In listening with the imagination and holding the image gently, you may find, as the dreamer did, that when scrolling over the options for fish, 
“fish Goddess or Woman,” feels right or sounds interesting or recalls something of the quality of the dream. When this selection is highlighted, 
click or double-click “fish Goddess or Woman.”  Select the first image on this page 2Bh.801 “Fountain as a goddess with a vase.”
 
 

ARAS Search screen
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To enter the record, place the cursor over the record number. This will change the underlined 
number to a bright yellow. Click on this yellow number or either one of the photographs to enter 
the detailed record. 

Selecting the record locator number will show both photos in the image display screen on the left 
of the Main Commentary page. Alternately, if one or the other photograph is chosen, only one 
will display at a time. 

ARAS Search result example

Visit each photograph within a record with more than one image by 
clicking the left and right arrows beneath the image screen. The “Main” 
button will bring you back to a view of all images in the record. 

ARAS Record example
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      Upon first sight of the record, the dreamer responds to the feminine figure, 
to the fish, flowing water, and flowing garments that relate to her dream. While 
reading the Main Commentary Description, the dreamer also finds things that 
touch her, hold meaning for her, in relation to her dream. These items are shown in 
bold italics in the paragraph:

Select the “Zoom In” tab beneath the 
images and click on the center of the 
area you would like to zoom in to see. 
By zooming in on the garment, new 
detail reveals itself. When enlarging 
an image, the screen will often show 
a pixelated image or one that 
appears blurry. Allow a moment and 
the image will become clearer. 

To reduce the image size click the 
“Zoom Out” button.

detail of fish in 
folds of dress 

As the source of fresh waters, this unidentified fertility goddess 
possessed life-giving power. Streams are shown flowing down her skirt 
and in them swim fish, a symbol of the abundant life she sustains. Once, 
water poured forth from the vase in her hands. [...]

Goddess [...] wearing horned headdress, elaborate jewelry (multiple 
earrings, necklaces, and bracelets), and garment with scalloped sleeves 
and long skirt decorated with ripple pattern up which swim three 
bands of fishes; holding in her hands a vessel connected to an inferior 
canal, running vertically to her base, through which water once flowed.

Fish are part of the fabric of the garment and they originate from the Goddess and from the vessel in her hands. The 
dreamer has, for some time, also had a strong interest in vessels and their symbolic meaning. In her further exploration, 
she will find how the books in the Jung Institute Library and the images of the Archive complement one another. Buffie 
Johnson, in her  book,  Lady of the Beasts, describes how the “vessel of the fish,” or vesica piscis from Latin, points to the 
vessel as feminine, as a womb, and to fish as symbolic of generation and rebirth (224). The finned, gilled creatures appear 
in ceremonies and writings, in the signs of stars as astrological Pisces, and in the outline of the mandorla, which means 
“almond” in Italian. 
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The Mandorla
In the collection mandorlas appear in a variety of ways:

Object with the outer shape 
of a mandorla 

ARAS: 5Eo.510

Venus standing in 
mandorla above  

fruited tree
ARAS: 5Fb.015

Zodiac Man within mandorla 
ARAS: 5Fk.042

Shakyamuni 
ARAS: 7Lf.002
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To print the images or commentary, go to the Print menu below the ARAS page heading and use the drop-down list to 
highlight and select image, commentary or order slides.

For instructions on how to save images  for PowerPoint presentations, go to the Help menu and select PowerPoint.

 
Almond-shaped fish adorn the garments of the Goddess and the section titled “Cultural Context” includes a description of the 
vessel she holds as a source; “an ancient and potent Mesopotamian symbol of life-giving fresh waters, on which the fecundity of 
plant and animal life depends.”

The search may lead one from the creativity of the Goddess and source of the waters of life and into an interest in more images 
relating to this statue, this fountain contained within the walls of the king’s courtyard. Paragraph C within Cultural Context 
indicates another record from the same geographical location and time period, 2Bh.804, a wall painting. This painting reveals that 
the statue is a three-dimensional portrayal of an image in the painting. This record reveals another source of fish and water:

The Description for 2Bh.804 states:

Lower register: Two goddesses wearing horned crowns hold vessels from which 
plants sprout and streams full of fishes flow.
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An alternate way to explore images is to select “View other records from this era.” Select the arrow pointing to the left and 
click through four records using the “View other records from this era”  tool until you see the torso of a figure wearing 
flowing garments holding a vase pouring forth water  (2Bh.329). The water and fabric echo one another in pattern and 
movement. In zooming in, more fish are found swimming in the “living water.” As in the previous image, the fish swim in 
both directions, to and from the source.

When zoomed in, move the image to see other areas by placing the arrow 
of the mouse over a part of the image, the center for example, and clicking 
and holding the mouse button down. While continuing to hold the mouse 
button down, drag the mouse on the mousepad up and down or left and 
right or diagonally. If you get to an edge and cannot move further release 
the button and select another place on the image. If you need to exit this 
mode and begin again, select Full on the menu beneath the image and the 
image will return to the size at which it originally appeared.

Try the Zoom In tool to see the 
detail of the fish swimming in 
both directions.
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The dreamer feels a connection to this image. She connects more deeply with it when she reads the Description. The text 
reflects words and images that hold a charge for her:

This vessel of two streams was the Mesopotamian symbol of the living water of The Land of 
the Two Rivers. Contenau describes the figures as two divinities; the Encyclopédie 
photographique as two figures, each holding vessel by one hand, other hand about 
companion, at least one of the figures as feminine judging by long hair hanging down back 
and ruffled and draped costume. The fish at the side of the water instead of in it follows 
Sumerian art tradition, which places hidden object alongside whatever hides it. Moortgat 
describes it as two goddesses, and the pendant in b) as a counter-poise for a heavy necklace.

Try selecting the (b) image, then return to the main screen of two images by selecting “Main”.

The dreamer finds possibilities to follow from these records as each contains the quality of fluidity with commentary 
about vessels from which water flows resulting in continuous renewal for the land and waterways abundant with fish. She 
finds a resonance with the garments or robes and with the feminine, which lead her to explore Archetypes in this image 
at the bottom of the Main Commentary page.

This initial search might yield a new sense of the Goddess, the vessel of the 
feminine held in a sacred manner that honors the fluidity of life. The dreamer 
is touched at her core by a sense of the importance of water and how it means 
life for human beings. She feels acutely aware of the current situation in the 
world and the necessity for all beings to have access to clean water. There is 
an element of concern and a return to the image and the abundance, the 
overflowing naturalness of life. The water seems to flow both out from and 
into the vessel while the fish swim back toward the source. She relates to the 
water as faith and the vessel as containing the life-giving force, the creative 
spirit that continually comes forth.

This understanding might lead to a turn to explore vessels and the feminine. 
In the Search box type in “vessel” and go to the drop down menu to the listing 
that says: Vessel, Feminine. On the third page, the image that our dreamer has 
a resonance with is that of a Goddess, perhaps the Goddess of Love, 
Aphrodite (3Hd.700). 

The image calls to the dreamer inciting the feeling of the 
motion of dancing in robes in the dream. The record states, 
“The gesture of exposure, (...) the arm across the body, a sign of 
gratitude; the offering of a dove. The latter, held against the 
torso was particularly popular in the Greek islands and the East.”
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Next, type “dancing” in the Search box following the thread 
that has a strong impact on the dreamer. The first image of 
dance and diaphanous dresses (2Ad.090) touches her deeply. 
In this image, women keep the beat while bare-chested girls 
perform a dance, possibly of Hathor, goddess of music and 
dance, love, and joy. The girls illustrate a very human quality 
and unity in the arching of their backs and reaching out in a 
scene where everyone participates. The dreamer felt a  
resonance with the text, firstly, under the Description section 
in this record and, secondly, from the Cultural Context:

On the left of each register appear two standing 
women who wear short wigs and white 
diaphanous dresses, beneath which the outline 
of their bodies can be seen. (...) The dancers 
stand on their right legs, with torso tilted and 
head thrown back as they arch their backs in 
time to the music. In a pose of exaltation, they 
fully extend their left legs in a high kick while 
their arms are raised up in a parallel gesture. The 
artist has produced a visual purr by associating 
the tassels of the dancers with the hieroglyph 
for “placenta” (also shown as a white circle). (...)

On her (Hathor’s) feast day, dancers may have 
begun their procession at the goddess's temple, 
the “home of intoxication, the place of 
enjoyment,” and danced through the streets, 
distributing Hathor's blessings by means of 
chants and ritualized movements.

The image speaks as another expression of feminine creativity with the symbol of the placenta and the presence of the 
goddess recalling the vesica piscis, the mandorla, and womb. “Compositions of this type were intended to perpetuate the 
funeral festivities for eternity, magically protecting, nourishing, and entertaining the deceased” (2Ad.090). The lyrical 
collaboration and fluidity of dancers connect the dreamer to the feminine where the moisture and richness of creative joy 
belongs as a necessary part of life and its cyclical nature of death and rebirth, of the exchange and interchange that 
conceals, reveals and transforms. Another portion of the record reveals:

Hathor was perhaps the most many-sided of all the deities of the Egyptian pantheon. Especially 
as goddess of love -- and lust as well -- she represented powerful forces in the human psyche. 
She “personified effervescent divine life and passion” and thus represented urges that had to be 
calmed or appeased (Bleeker, 57).

Within the Archetypal Significance the record reads:

(...) With the hieroglyph for the placenta in a funerary context, this scene suggests rebirth in the 
next world as well as invoking fertility for the continuing of life in this world. The association of 
Hathor with the life of women establishes her as protectress of female experiences and activities.

Page 10



The funerary festivities and dances celebrate life’s joy and bring consciousness to one’s individual source and 
associations to one’s social connections and cultural heritage. The dreamer’s response to the funerary rites connects her 
to the recent loss of someone close to her. The dancing and creativity relate to her personal creativity. In the 
commentary of the image, the dancers’ skirts are referred to as kilts, which the dreamer also responds to due to her 
Celtic heritage. An individual’s particular background roots them in mythological material and spiritual traditions that 
can be valuable places of reference.

In conjunction with her Celtic background, a return to the fish of the dream and the number three reveals an intertwined 
symbol of the tripartate Goddess predating the Christian meaning of the masculine trinity ascribed to it. The triangular 
image of the triquetra is made of three interwoven vesica piscis. Celtic tradition recognized the fish as a feminine symbol 
of return and renewal and water as a symbol for the flow of the divine feminine principle. The triquetra unites three 
aspects of the goddess: maiden, mother, and crone. The three parts of the whole are about birth, giving birth, and death 
and the continuous interplay of the web of life. Fish with their perpetually open eyes invite new perspectives and the 
three fish together in this image are associated with rebirth and renewal through the water of life. 

Fish are considered sacred in many religious traditions. In mythology and fairytales, fish play various roles. In life, salmon 
born in fresh water return to the saltwater sea of their ancestors and swim upstream, revisiting their freshwater 
birthplace to spawn new generations. In places around the world, salmon, with their silvery skin and pinkish-red flesh,
are prized as a delicious and nourishing food. In relation to the dreamer’s Celtic background, the ancient Celtic symbol of 
salmon has associations with inspiration and prophecy, with knowledge and wisdom. Celtic mythology reveals that 
salmon gained wisdom by consuming the sacred hazel nuts from the well of Segais. The stories tell how one could then 
gain the wisdom of the well by eating this salmon.

The dreamer feels a resonance with the fluid strength of the water, with the dance, the fish in the folds of the gowns, 
with the triquetra, and the Celtic tale as she enters the third phase of her life for she feels the dream carries an initiatory 
experience traversing the maiden and mother phases and her movement into her wisdom years. She wears a necklace 
with a medallion over her heart containing a picture of her grandmother, her ancestress, and feels the need to grow into 
her nature as a wisdom keeper. By consciously holding a space for and lovingly tending these images, the dreamer has 
experienced a transformation within herself and touched us in her sharing.

Reference: Johnson, Buffie. Lady of the Beasts: Ancient Images of the Goddess and Her Sacred Animals. San Francisco:  
Harper and Rowe, 1988.

In gratitude to all those who helped in the creation of this tutorial and to those whose participation in it and exploration of it 
adds to its depths and wonder...

Among those, I would like to expressly thank: Richard Hassen and To the Point Design Studio, Patricia Sohl, Ami Ronnberg, Allison 
Langerak, Kathleen Russ, Deborah Wesley, Tom Singer, and Baruch Gould.
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To enter the record, place the cursor over the record number. This will change the underlined number to a bright yellow. Click on this yellow number or either one of 
the photographs to enter the detailed record. 

Selecting the record locator number will show both photos in the image display screen on the left of the Main Commentary page. Alternately, if one or the other 
photograph is chosen, only one will display at a time. 

At the top and bottom of the search Results Page, click on  “See as animation,”  to see a flowing procession of the images  found in that particular grouping. If 
you would like to follow an image, put the cursor over it and click.     

Visit each photograph within a record with more than one image by clicking the left and right arrows beneath the image screen. The “Main” button will bring you 
back to a view of all images in the record. 

Select the “Zoom In” tab beneath the images and click on the center of the area you would like to zoom in to see. By zooming in, new detail reveals itself. 
When enlarging an image, the screen will often show a pixelated image or one that appears blurry. Allow a moment and the image will become clearer. 

To reduce the image size click the “Zoom Out” button.

To print the images or commentary, go to the Print menu below the ARAS page heading and use the drop-down list to highlight and select image, commentary or 
order slides.

When zoomed in, move the image to see other areas by placing the arrow of the mouse over a part of the image, the center for example, and clicking and holding the 
mouse button down. While continuing to hold the mouse button down, drag the mouse on the mousepad up and down or left and right or diagonally. If you get to an 
edge and cannot move further release the button and select another place on the image. If you need to exit this mode and begin again, select Full on the menu beneath 
the image and the image will return to the size at which it originally appeared.

Technical Keys:
If you are looking for a source of inspriration, try selecting Search and then select Discover.  This will bring up a montage. You may then  click an image 
as it floats across the screen to see the image’s record details. Once you have clicked an image, selecting Discover a second time on the drop-down 
menu will take you to a new motif.  (Keys such as this are interspersed throughout the tutorial.)

 In moving the cursor over the drop-down list, the different keywords are highlighted. If a selection is made inadvertently, one may choose to follow the 
lead or use the left arrow or back button at the top of the screen to return to the previous drop-down menu. Additionally, if you would like to change the 
text size, go to the View menu at the top of the page and select Zoom In or Zoom Out.

For instructions on how to save images  for PowerPoint presentations, go to the Help menu and select PowerPoint.
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